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Trouble Shooting

Problems When Working in Program
Need to Alter Normal Pay Period End Date
Problem: Because of a holiday or shut down, you need to use a end of pay period date

other than normal date and the program will not allow you to use a different date.
Cause: Program is set to process paydays that are on a regular schedule.
Solution:  Process payday with normal end of pay period date, since you will be going back

to the same schedule after the holiday or shut down.  If for some reason you
need to change the base date or alter pay period on a permanent basis, see
Special Situations “Change Pay Schedule” in this manual.
If the holiday, vacation or shut down is prepaid, you may want to review Special
Situations “Prepaying a Payday” section in this manual.

Negative Amount Appears in “Withheld for Garnishment”
Problem: You are entering Payroll data for the third, fourth or fifth pay period of the month

and a negative amount appears in the “Withheld for Garnishment” field.
Cause: The employee had more earnings for earlier pay periods of the month and the

current earnings were much less, dropping the monthly total, enough that money
that was withheld for garnishment during earlier pay periods is now to be
returned to the employee.  Garnished amounts must be figured on the total
month, rather than on the per pay period basis, when an employee’s earnings
change during the course of a month, there will be occasions when previously
withheld amounts will be returned to the employee.

Solution:  Use the “Net Pay” amount to cut the check for the employee.  The “Net Pay”
takes the “Disposable Earnings” subtracts “Support Withholding” and “Prior
Liens” and adds the amount to be returned to the employee in “Withheld for
Garnishment” and gives you the total net to pay employee.
When final worksheets are printed the negative amount withheld will be
calculated in the total withheld for the garnishment month.  Since you have not
yet paid out the previously withheld amounts to the creditors, you are returning
money to the employee from the funds that you are holding for the creditors.

 “Preliminary” Prints on Final Worksheet
Problem: You are trying to print the final worksheet of the month, but the word

“Preliminary” appears in a box on the worksheet.
Cause: A Preliminary Worksheet is any worksheet that is printed before all pay data is

locked.  Most likely one or more pay periods have not been locked.
Solution:  Go to “Employee Information” in the Task Center, then choose “Enter Employee

Status Change”.  Select employee, then click on the “Worksheet” button.
Choose the month you are trying to process and click on the “Worksheet” button.
Look at each pay period and the totals to see if “Data Locked” box is X’ed.  Go
back into “Process Garnishment Payday” and lock the pay roll data that is not
locked.  Then reprint the Worksheets.
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“You must enter a valid date” Message
Problem: You are trying to process a payday, answer or distribution and get the message

that “You must enter a valid date”.
Cause: The date you have typed in is inappropriate.
Solution:  Look at the date that you have entered for processing.  Check to make sure that

there are no extra numbers, letters, dashes or slashes.  Re-enter appropriate
date and choose “Next”.

“You have not entered a valid pay date” Message
Problem: You are trying to process a payday, answer or distribution and get the message

that “You have not entered a valid pay date”.
Cause: The date you have typed in is inappropriate.
Solution:  Look at the date that you have entered for processing.  Check to make sure that

there are no extra numbers, letters, dashes or slashes.  Re-enter appropriate
date and choose “Next”.

“Error #” Prints on Report
Problem: You are printing reports and “Error #” appears in the totals column.
Cause: This message appears when the total of several numbers equals 0.

Programming problem with Microsoft Access, for some reason 0 + 0 does not
equal 0, but Error #.

Solution:  Before printing reports, “Preview” them to see if you get the “Error #” message.  If
you do, the totals are 0, and it is not necessary to print the reports.

"It appears that payday processing for (date) has not yet been completed.  Do you wish
to proceed?" Message
Problem: You are beginning to proceed a new pay period, having locked the

previous pay period and get the message:  "It appears that payday processing for
(date) has not yet been completed.  Do you wish to proceed? "

Cause: You have processed and locked the payday and gone back into
the payday to print out reports or worksheets, without following through to step
seven to lock the payday.  The program thinks that the pay period is not locked,
however it is.

Solution: You can choose "Yes" when you get the above message and proceed,
ignoring the message or when you go back into a locked pay period to print
reports or worksheets, simply go through all the steps and "re-lock" the pay
period.

 “No income withholding or garnishment is required for this pay date” Message
Problem: You are trying to process a payday and get the message that “No income

withholding or garnishment is required for this pay date”.
Cause: The date you have typed in does not fall in line with the base date entered in the

pay schedule information.
Solution:  Check the pay schedule information by going to “Maintenance” in the Task

Center and choosing “View Pay Schedule List”.  The base date listing must fall
consistent with the pay schedule checked above it.
For example: the end pay period date for monthly and semi-monthly are going to
fall on the same day of each month, for example the 1st, 15th, 30th or 31st.  The
weekly and bi-weekly pay periods are processed on a set day of each week or
every other week, such as Friday or Saturday.
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Make sure that the date you have entered falls in line with these parameters.
Make sure employees are entered and listed as currently employed, by choosing
“Employee Information” and “Enter Employee Status Change” select employee
that you know has a current garnishment or income withholding and “Edit”.  Look
at the bottom of the Employee Information window.  It should say, “Currently
Employed”.
Make sure that Garnishments are entered and the date the Garnishment was
received falls into the Garnishment period and has not been released.
Make sure that the Income Withholding Orders are entered and the date the
Order was received falls into the withholding period and has not been terminated.

Work Around for Locked Worksheets and Answers
Problem: You have accidentally locked a Pay Day Worksheet and/or Garnishment Answer,

with incorrect pay information and cannot go back in and unlock that Pay Day.
Cause: Legally we cannot allow the unlocking of Worksheets and Answers, once they

have been printed, because it would be too easy to falsify records.  You need to
be very sure that your figures are complete and correct before you lock the
Worksheets or Answers.

Solution:  You need to print the Garnished Employee Pay Report after you have entered
the payroll data and carefully check the figures before proceeding to lock the
data in.  You must however lock the data before printing the Answers.
There is no easy way to work around an incorrect entry that is locked, however, if
you must revise your figures there is a way as follows:

Step One – Have Records Available
Before you begin, make sure that you have a copy of the printed Answer from the last
correct month.  You will need to have the Answer Page Two for the “Amount of Judgment after
this payment”.  You will also need to have the original Order for Garnishment and any
changes or revisions in address that you may have received from the Judgment Creditor.

Step Two – Change Employee Name
1. Go to “Employee Information” in the Task Center and choose “Edit Employee

Information”.
2. Left mouse click once on employee.
3. Click on the “Edit” button.
4. Change the Employee Name to read their name followed by (old).  For example:  Joe

Doe (old).  This is so that you will know which entry is corrected.
5. Then “Close”.  Closing saves changes.

Step Three – Release Garnishments
1. You must manually release all Garnishments for the employee that you need to rework.
2. Choose “Garnishment” from the Task Center and “Update or Release Garnishment”.
3. You will then need to select the desired employee.
4. Click on the “Garnishment” button.
5. Then you will need to select each Garnishment that needs to be released.
6. Click on the “Release” button and enter the date that the last correct Answer was

processed.  This date should be the end of the previous month.
7. Then “Close” the window to save the entry.
8. Repeat for each Garnishment for the employee that you need to rework.



40

Step Four – Re-Enter Employee
1. Next you need to set up the Employee information as if he/she is a new employee.
2. Choose “Employee Information” from the Task Center, and then choose “Edit Employee

Information”.
3. Click on the “Add” button.
4. Complete the Employee Information.
5. Click on the “Close” button when the employee information is completed to save.

Step Five – Re-Enter Garnishment
1. In “Employee Information” from the Task Center, choose “Edit Employee Information”.
2. Select the Employee [be sure to get the one that does not say (old)].
3. Click on “Garnishment” button.
4. Then the “Add” button.
5. Complete the Garnishment Information.  The creditor should already be in the drop-in

database.  You will need to make any revisions that have come to you since the original
Order for Garnishment was sent.  Enter the Date that you were originally served with the
Garnishment as the “Date Garnishment Served”.  The “Current Judgment Amount”
should be the Amount of judgment after this payment from the last correct month that the
Answer was sent out, unless you have received a revised amount from the Judgement
Creditor since then.

Step Six – Process Payday
1. Beginning with the first pay period after the last correct Answer, enter the pay roll data.
2. Choose “Periodic Processing” from the Task Center and then “Process Garnishment

Payday”.
3. Enter payroll data, using the Pay Day Processing Wizard.
4. Before you lock each pay period, you should print a “Pay Day Report “after you have

entered the payroll data.  Check the data you have entered very carefully to make sure
figures are correct.  Then proceed to “Lock Now”.

5. Repeat procedure for each pay period since the last correct Answer.

Step Seven – Print Worksheet
1. If there is more than one pay period, you do not need to print each preliminary

Worksheet for each pay period.  You will want to print Worksheets for each individual
employee, since printing the batch will give you Worksheets for both the incorrect (old)
and corrected employee.

2. From the Task Center, choose “Employee Information”.
3. Choose “Add or Edit Employee Information”.
4. Select the employee you need to print a Worksheet for.
5. Then choose the “Worksheet” button.
6. Select the month that you need to print.
7. From the “File” pull down menu select “Print”.
8. Set number of copies to print.
9. Push the “Print” button.
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Step Eight – Prepare Answer
1. Choose “Periodic Processing” from the Task Center and then “Prepare Garnishment

Answer”.
2. Enter the Month that you need to prepare the Answer for and click “Next”.
3. Make sure that the “⌧ Do you want to print Answers?” box is not marked.  You will want

to print Answers for each individual employee, since printing the batch will give you
Answers for both the incorrect (old) and corrected employee.

Step Nine – Print Answer
1. From the Task Center, choose “Employee Information”.
2. Choose “Add or Edit Employee Information”.
3. Select the employee you need to print a Answer for.
4. Then choose the “Answer” button.
5. Select the month that you need to print.
6. From the “File” pull down menu select “Print”.
7. Set number of copies to print.
8. Push the “Print” button.

Once you have completed the Distribution process, including “Lock and Release”, the incorrect
(old) garnishments will be released, since you have manually released them during the month.
When you do the payday processing, after that, the (old) employees will not appear in the “Pay
Day Worksheet Data Entry” employee list.

Error Messages
Frequently when window messages appear on the screen they are caused by insufficient

memory in some way.
For various reasons computers sometimes do not execute correctly.  Many problems can

be cleared up by simply shutting the computer down and restarting it.  Error Messages may be
fixed by one of the following solutions.  Please
carefully read the “Problem” in the following
sections and try the procedures that seem
applicable to your problem.

Error Message When Starting From a
Desktop Icon
Problem: NDF encounters a runtime error

immediately on startup, when
started from a desktop icon.

Cause: Desktop icon may not have been
created correctly.

Solution:  Verify desktop icon.

Windows 95, 98, NT, ME, 2000 or XP
1. Right click on the NDF icon, select

“Properties”.
2. Click “Shortcut” tab.  The shortcut target

should resemble the illustration shown here,
(drive letter may not be “C”).
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If the shortcut target does not resemble the illustration, delete the shortcut and follow correct
instructions for creating desktop icon, as follows:

Windows 95, 98, NT, ME or 2000
1. Right click on “Start”, click on “Open”.
2. Right click on “Programs”, click on “Open” (Windows 2000 use “Open All Users”).
3. Right click on “NDF Withholding”, click on “Open”.  (You are now in the NDF Withholding

Program Window.)
4. Right click on the main “NDF Withholding” program, then click “Create Shortcut” and drag

the shortcut icon to the desktop.

Windows XP
1. From “Start”, choose “All Programs”,
2. Then choose “NDF Withholding”,
3. Right click on NDF Withholding, then click “Create Shortcut”.
4. Then click on “NDF Withholding (2)” and drag it to the desktop.

Error Message When Working in the Program (System Resources)

Problem: You get an error message when working in the program.
Cause: Computer does not have enough in System Resources (memory in Random

Access Memory “RAM”) available to handle the program.
Solution:  Close programs that are not in use to make more RAM available for the use of

the NDF Garnishment Program.  Please note that the NDF Program requires 24
MB of RAM with Windows 95, 32 MB of RAM with Windows 98 and 64 MB of
RAM with Windows 2000, ME or NT.

How to check System Resources

Windows 95, 98, NT or ME
1. Right click on the “My Computer” icon.
2. Select “Properties”.
3. Click “Performance” tab.
4. Look at System Resources.  System Resources should not be less than 40% because the

system may not be able to function properly (85 percent is good).  You can increase the
system resources available by exiting any programs you are not using (everything but
Windows) before going into the NDF Program.  Sometimes restarting your computer may
clear up and make more resources available.

Windows 2000 or XP
Windows 2000 and XP are set up a little different from other Windows programs, in that you

can use some of your hard drive when you do not have enough RAM for the programs that you
are running.  For best performance, do not set the initial size to less than the minimum
recommended size under “Total paging file size for all drives”.  The recommended size is
equivalent to 1.5 times the amount of RAM on your system.  Usually, you should leave the
paging file at its recommended size, although you might increase its size if you routinely use
programs that require a lot of memory.

If you decrease the size of either the initial or maximum page file settings, you must
restart your computer to see the effects of those changes.  Increases typically do not
require a restart.
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Windows 2000
1. Right click on the “My Computer” icon and select “Properties”.
2. Click the “Advanced” file tab and select “Performance Options”.
3. Under “Virtual Memory” click “Change”.
4. Under “Drive [Volume Label]” click the drive that contains the paging file you want to

change.
5. Under “Paging File Size for selected drive” type a new paging file size in megabytes in the

“Initial size(MB)” or “Maximum size (MB)” box, and then click “Set”

Windows XP
1. From “Start”, choose “Control Panels”,
2. Then choose “Performance and Maintenance”,
3. Then click “System”.
4. On the “Advanced” file tab, under “Performance”, click “Settings”.
5. On the “Advanced” file tab, under “Virtual memory”, click “Change”.
6. Under “Drive [Volume Label]” click the drive that contains the paging file you want to

change.
7. Under “Paging file size for selected drive”, click “Custom Size”, and type a new paging file

size in megabytes in the “Initial size (MB)” or “Maximum size (MB)” box, and then click “Set”.

Error Message After Installation of Update
Problem: You get an error message when trying to use the program after installation of an

update.
Cause: Original Program and Update have not been installed to the same location on

your hard drive.
Solution:  Locate the original program installation and reinstall the update to the same

location.

How to Check Location of your Original NDF Software
Windows 3.1

1. In the “Program Manager” window, open “Main”.
2. Then open “File Manager”.
3. Locate the NDF folder on the hard drive.  Double click on the NDF Program file. If the

program you get into is the original with your data records, this is the location that you want
to keep.  Check other drives until you find the program that does not allow you access to the
program.  Delete the improperly installed update files.

4. Record the correct location of your original NDF software program in the installation pages
of this manual for future reference.  The drive letter is listed on the top of the “tree” usually
the hard drive is “C”, but you may have more than one hard drive.  A Path Directory lists the
drive letter first, followed by a colon and backslash, then the folder name (for example
“C:/NDF”).  Be sure to include any sub-folder names, when the NDF Program is listed in a
sub-folder.
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Windows 95
1. Right click on the “My Computer” icon on your desktop.
2. Then choose “Explore”.
3. Check your different hard drives by clicking on the + sign in front of the folders until you find

the NDF folder.  Double click on the NDF Program file.  If the program that you get into is the
original program with your data records, this is the location that you want to keep.  Check
the other drives until you find the program that does not allow you access to the program.
Delete the improperly installed update files.

4. Record the correct location of your original NDF software program in the installation pages
of this manual for future reference.  You can figure out the path by following the folders and
names.  A Path Directory lists the drive letter first, followed by a colon and backslash, then
the folder name (for example “C:/NDF”).  Be sure to include any sub-folder names, when the
NDF Program is listed in a sub-folder.

Windows 98, ME, NT or 2000
1. Right click on the “My Computer” icon on your desktop.
2. Then choose “Explore”.
3. Check your different hard drives by clicking on the + sign in front of the folders until you find

the NDF folder.  Double click on the NDF Program file.  If the program that you get into is the
original program with your data records, this is the location you want to keep.  Check the
other drives until you find the program that does not allow you access to the program.
Delete the improperly installed update files.

4. Record the correct location of your original NDF software program in the installation pages
of this manual for future reference.  Once you have opened the folders, the “Address” line at
the top of the window will give you the directory path, for example “C:/NDF”.  A Path
Directory lists the drive letter first, followed by a colon and backslash, then the folder.  Be
sure to include any sub-folder names, when the NDF Program is listed in a sub-folder.

Windows XP
1. When working from a desktop icon, right mouse click on the icon, choose “Properties”.  In

the “Target” line look for the string that reads”…MSARN200EXE
F:\NDFGARN\garnish\garnish…’’.  The underlined drive represents the drive letter that your
software is installed on.

2. From “Start”, choose “All Programs”, then “NDF Withholding”, then right mouse click on
“NDF Withholding” and choose “Properties”.  In the Target line, look for the string that reads
“…MSARN200EXE F:\NDFGARN\garnish\garnish…”.  The underlined drive represents the
drive letter that your software is installed on.

Installation Incomplete
Problem: Message “Installation is not successful”.
Cause: The computer was not able to install all of the NDF files on one drive (usually

because C drive was too full) and some of the files were installed on a different
drive. All NDF files must be on the same drive.

Solution:  Delete NDF files from the various drives they were installed on and make sure
that there is enough room on the drive that you are installing to before beginning
installation.  Reinstall the NDF Program from the original disks and the latest
update that you may have, being sure that all the files go onto the same drive.
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Repair NDF Data Program
Problem: On occasion the program does not appear to function properly.
Cause: Information on databases is subject to minor corruption.
Solution:  The Repair NDF Data program will usually fix the program.  Close the NDF

Garnishment Program. Then double click on the “Repair NDF Data” icon that was
installed when you installed the NDF Program.  The NDF Program screen will
appear, and the cursor will become an hourglass.  When the hourglass
disappears, the repair is complete.

If for some unforeseen reason your database gets corrupted, NDF.mdb will try to repair
itself.  Data stored within the program will not try to repair itself.

Printing Problems
Improper Printout or Printing Blank Pages
Problem: You have problems with improper printout, blank pages usually, especially when

using Windows NT.
Cause: You may be using an incompatible driver or the wrong driver for the hardware

that you have.
Solution:  We recommend the printer use the generic NT Driver from Microsoft.  If you have

an Hewlett Packard Printer chances are you are using the printer driver from
Hewlett Packard that is specifically for your printer model and it causes problems.
Experience has shown that the generic Hewlett Packard driver usually works.
Try different drivers.  There usually is a whole list of drivers available to choose
from.  Print Drivers can be changed by using one of the following methods.

Windows 3.1
You can install a printer driver provided with Windows for Workgroups or Windows printer

driver supplied by a printer manufacturer or computer dealer.
1. Go to “Main”.  Open the “Control Panel” window, choose the “Printers” icon.
2. Choose the “Add” button.  If you have not installed a printer, “Control Panel” chooses the

“Add” button for you.
3. In the “List of Printers” box, select the printer you want to install.  If your printer is not listed

or does not emulate a printer that Windows supports, but you have a printer driver for it,
select “Install Unlisted or Updated Printer”.

4. Choose the “Install” button.  Go to step 7 if the printer you are installing uses the same
printer driver as another printer already installed on your system.

5. Insert in drive “A” the disk containing the printer driver (should come with the printer), or type
“A” drive letter and directory path in the text box.  You can also use the “Browser” button to
find and select the drive and directory where the printer driver is located.  When you finish
using the dialog box, choose the “OK” button.

6. In the “Install Printer” dialog box, choose the “OK” button.  If you are installing a driver not
included with Windows for Workgroups, a dialog box appears, listing several printers.  Select
the printer you want, and then choose the “Install” button.

7. If the Control Panel prompts you for font files, insert the disk that contains font files.  Then
choose the “OK” button.  The printers name appears in the list of installed printers.
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Windows 95, 98, NT, 2000 or ME
1. From “Start” go up to “Settings”.
2. Then choose “Printers”.
3. Click once on your printer icon, go up to “File” on the toolbar and come down to “Properties”.
4. Click on “Details” (Windows 2000 choose “Advanced).  The print driver information is in the

middle of the window that comes up.  You can choose another driver by clicking on the
down arrow button and scrolling through the drivers and printers available.  When you have
chosen the new driver, click the “OK” button.  (You may need your Windows Installation
Disk.)

Windows XP
1. From “Start”, choose “Control Panel”.
2. Then “Printers and other Hardware”.
3. Under “pick a Control Panel icon” choose “Printers and Faxes”.
4. Choose the printer you are using and then in the “Printer tasks” box on the left side of the

screen, choose “Set printer properties”.
5. Under the “Advanced” file tab, choose the “New Driver” button.  You can choose another

driver by clicking on the down arrow button and scrolling through the drivers and printers
available.  When you have chosen the new driver, click the “OK” button.

Improper Printout or Printing Blank Forms from HP Printers
Problem: You have problems with improper printout, the form prints, but data is missing

when printed from a HP Printer.
Cause: Meta files are not handled as transparent on all HP Printer drivers, they are

programmed to appear transparent with the data entry file located underneath,
printing at the same time.

Solution:  We recommend the printer use the generic HP Driver (not the print driver for your
specific printer model).  If you have a Hewlett Packard printer, chances are you
are using the printer driver from Hewlett Packard that is specifically for your
printer model and it causes problems.  Experience has shown that the generic
Hewlett Packard driver usually works.  You can do this one of two ways.
First, you can change the print driver so that all printing uses the generic print
driver.  Sometimes this can cause problems with printing from other programs.
The alternative is to add a printer to your list of printers and modify that particular
printer for use with the NDF Program.  You would need to be sure to designate it
as the NDF Printer and also to choose the NDF printer as the default printer
before you go into the NDF Program.  The NDF Software Programs always
print to the default printer.  To make switching back and forth from one driver
to another easier, you can create shortcut icons for each printer for your desktop
(see section below “Creating Printer Shortcut Icon”).
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Change your Print Driver

Windows 95, 98, NT, 2000 or ME
1. From “Start” go up to “Settings”.
2. Choose “Printers”.
3. Click once on your printer icon or choose “Add printer”, go up to “File” on the toolbar and

come down to “Properties”.
4. Click on “Details” (Windows 2000 choose “Advanced”). The print driver information is in the

middle of the window that comes up.  You can choose another driver by clicking on the
down arrow button and scrolling through the drivers and printers available.  When you have
chosen the generic HP Print Driver, click the “OK” button.

Windows XP
1. From “Start”, choose “Control Panel”,
2. Choose “Printers and Faxes”,
3. Then under the “Advanced” file tab, choose the “New Driver” button.
4. The “Print Driver Wizard” appears choose “Next”.
5. Then select a new driver (generally model specific printers do not work as well as generic

printers).  Choose “Next”.

Add Printer

Windows 95, 98, ME, NT or 2000
1. From “Start” choose “Settings”.
2. Then “Printers” and “Add Printer”,
3. The Add Printer Wizard comes up.  Choose “Next”.
4. Choose whether it is local printer or network printer and click on “Next”.
5. On the right side of the next window, choose the manufacturer as HP.  In the Printer Column

choose HP DeskJet, HP CopyJet, HP Color LaserJet, HP OfficeJet, HP Paint Jet or HP
QuietJet. Just the name, with no model number or other words.  Then choose “Next”.

6. Rename the printer to NDF Printer.  Choose “Next”.
7. Since you are already using your printer, you do not need to print a test page, select “No”

and “Next”.  Then click “Finish”.

Windows XP
1. From “Start” choose “Control Panel”.
2. Then select “Printers and Other Hardware”.
3. Under “Pick Task”, choose “Add Printer”.
4. The Add Printer Wizard comes up.  Choose “Next”.
5. Choose whether it is local printer or network printer and click on “Next”.
6. The Printer Wizard will tell you that it cannot “Detect any Plug and Play Printer.  To install

the printer manually click “Next”.  Click “Next”.
7. Indicate the same port at the HP Printer is currently hooked up to, normally this is LPT1.

Choose “Next”.
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8. On the right side of the next window, choose the manufacturer as HP.  In the Printer Column
choose HP DeskJet, HP CopyJet, HP Color LaserJet, HP OfficeJet, HP Paint Jet or HP
QuietJet. Just the name, with no model number or other words.  Then choose “Next”.

9. Rename the printer to NDF Printer.  Choose “Next”.
10. Since you are already using your printer, you do not need to print a test page, select “No”

and “Next”.  Then click “Finish”.

Create Printer Shortcut Icon

Windows 95, 98, NT 2000 or ME
1. From “Start” go up to “Settings”.
2. Choose “Printers”.
3. Right mouse click on the printer you want to create the shortcut icon for and choose “Create

Shortcut”.  It will tell you that it cannot create a shortcut, click on “OK”.  Then it will ask you if
you want to place a shortcut to the printer on your desktop and click on “Yes”.

Windows XP
1. When you return to the “Printers and Faxes” folder, right mouse click on the NDF Printer and

choose “Create Shortcut”.
2. You will get the message “Windows cannot create a shortcut here.  Do you want the

shortcut to be placed on the desktop?”  Choose “Yes”.
3. Follow steps 1 & 2 for the other HP Printer.

Slow Printing, Blank Pages or not printing the Form Correctly
Problem: Slow printing or the form does not print correctly or may take extra pages to print

forms and insert blank pages in between.
Cause: Installed printer memory is set incorrectly.  Your computer may not be set to

recognize all of the memory available in your printer or it may attempt to
recognize more memory than is present in the printer.

Solution: Change the installed printer memory setting by using one of the following
methods.

Your computer should usually be set to recognize all of the memory in your printer, but not
more.

The NDF Program requires 1.5 MB of printer memory for a 300-dpi printer.  A 600-dpi printer
needs 4 MB.  A 1200-dpi printer needs 12 MB.

Setting Memory for Printer
Windows 3.1 or Windows 3.11
1. From “Program Manager”.
2. Open “Main”.
3. Then “Control Panels”.
4. Then “Printers”.
5. Then “Setup”.
6. Then click on “Options”.
7. Then click on “Advanced”.  Here you will see the amount of printer memory your computer is

set to recognize.  Virtual Memory can be changed to match the printer memory.  The
information on your printer memory should come with your printer.
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Windows 95
1. From “Start” go up to “Settings”.
2. Then “Printers”.
3. Double click on your printer.
4. Select the “Printer” menu.
5. Go down to “Properties”.
6. Choose “Device Option”.  You will see the amount of printer memory your computer is set to

recognize.  The printer memory has a bar with a pull down menu, click on the arrow and
choose the correct amount of memory for your printer.  The information on your printer
memory should come with your printer.

Windows  98, NT or ME
1. From “Start” go up to “Settings”.
2. Choose “Printers”.
3. Select your printer.
4. Select the “File” on the toolbar.
5. Go down to ‘Properties”.
6. Choose “Device Option” (“Device Settings” in Windows 2000). You will see the amount of

printer memory your computer is set to recognize.  The printer memory has a bar with a pull
down menu, click on the arrow and choose the correct amount of memory for your printer.
The information on your printer memory should come with your printer.
Try different settings if you do not know the amount of your printer memory.
You can also try changing the screen display.  Coloring and screen resolution can use a lot

of memory and there may not be enough memory to handle it.  See Screen Display.
Windows XP
1. From “Start” choose “Control Penal”,
2. Then choose “Printers and other hardware”,
3. Under “Pick a Control Panel Icon”, choose “Printers and Faxes”,
4. Right click on the icon for the printer you are using, then click “Properties”,
5. On the “Device Settings” tab, under “Installable Options”, click “Printer Memory”,
6. Then click the number that matches the amount of memory installed in your printer or

plotter.

Your printer has memory chips for storing information that is sent to it.  When you install
a printer, Windows reads the amount of printer memory so the printers and windows
work properly together.  When you install additional memory into your printer, you need
to change the printer memory setting in Windows, so that the two match.  If Windows is
set to expect more or less memory than actually resides in your printer, Windows may
display a memory message or work improperly.
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Improper Printout or Not Printing Form Correctly
Problem: You have problems with improper printout, only part of a page prints or does not

print all pages from a form prints.
Cause: Your hard drive may need to be checked for problems with the drive or you may

need to defragment your hard drive.
Solution: Run the scan disk program to see if there are any errors and then run the disk

defragmenter program to reorganize the hard drive so that all of each program
will be in the same place on the hard drive.  If you have more than one hard
drive, you should perform scan disk and disk defragmentation on each drive.

Windows 3.1 or 3.11

Scan Disk
1. Exit “Windows” by choosing “File” and “Exit Windows” from the “Program Manager” window.
2. When the DOS prompt comes up (C:\>) enter “scandisk” and push “Enter”.
3. Follow the instructions of the scan disk program.  It will tell you if there are errors and if it can fix

them.  You may be given the opportunity to create an “Undo Disk”, it is always wise to create an
undo disk.  If your computer works fine and you are not missing any files you can always reformat
the floppy disk.

4. Get back to Windows by entering “win” and pushing “Enter” at the DOS prompt (C:\>).

Disk Defragment
1. Exit “Windows” by choosing “File” and “Exit Windows” from the “Program Manager” window.
2. When the DOS prompt comes up (C:\>) enter “defrag” and push “Enter”.
3. Follow the instructions of the disk defragmentation program.
4. Get back to Windows by entering “win” and pushing “Enter” at the DOS prompt (C:\>).
Windows 95, 98, NT or ME

Scan Disk
1. From “Start” go up to “Accessories”.
2. Choose “System Tools”.
3. Then choose “Scan Disk”.
4. Then highlight the hard drive you need to scan and click on the “Start” button.
5. Follow the instructions of the Scan Disk program.  It will tell you if there are errors and if it can fix

them.  You may be given the opportunity to create an “Undo Disk”, it is always wise to create an
undo disk. If your computer works fine and you are not missing any files, you can always reformat
the floppy disk.

Disk Defragment
1. From “Start” go up to “Accessories”.
2. Choose “System Tools”.
3. Then choose “Disk Defragmenter”.
4. Follow the instructions of the Defragmentation program.
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Windows 2000 or XP

Scan Disk
1. Double click on “My Computer” icon on your desktop (Windows XP from “Start” choose “My

Computer”).
2. Then select the hard drive you need to scan.
3. From the “File” menu on the tool bar, choose “Properties”.
4. On the “Tools” tab, under “Error Checking”, click “Check Now”.
5. Under “Check Disk Options”, select the “Scan for and attempt recovery of bad sectors” check box.
Disk Defragment
1. From “Start” choose “Programs” (Windows XP choose “All Programs”).
2. Choose “Accessories”.
3. Choose “System Tools”.
4. Then choose “Disk Defragmenter”.
5. Click on the “Defragment” button.

Improper Printout or Not Printing Form Correctly
Problem: You have problems with improper printout, only part of a page prints or not all

pages from a form prints.
Cause: Your printer may not have enough memory.
Solution: Check the information that came with your printer and make sure that there is

adequate memory to handle printing the forms.  A 300 dpi printer needs 1.5 MB’s
of memory, a 600 dpi printer need 4 MB’s of memory and a 1200 dpi printer
needs 12 MB’s of memory.

Printing Too Many Copies
Problem: You request one copy of a form, but more print out.
Cause: Printer copies may be set to a number other than 1.
Solution: Check the printer setting by using the appropriate method for your operating

system.
Windows 3.1 or Windows 3.11
1. From “Program Manager” open “Main”.
2. Then “Control Panels”.
3. Then “Printers”.
4. Then “Setup”.  This window will show Copies and should be set to 1.  If not, change it to 1

and click the “OK” button.
Windows 95, 98, NT or ME
Method A
1. From “Start” go up to “Settings”.
2. Then “Printers”.
3. Then click on the Printer Icon.
4. Then select the Printer you want to use.
5. In the pull down menu select “Properties”.
6. Then “Paper”.  This window will show Copies and should be set to 1.  If not, change it to 1

and click the “OK” button.
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If you cannot get into Properties as described above, try Method B
1. From “Start” go up to “Settings”.
2. Then “Control Panel”.
3. Then “Printers”.
4. Click once to highlight the Printer Icon.
5. Then go up to the “File” menu, pull down the menu and select “Properties”.
6. Then “Paper”.  This window will show Copies and should be set to 1.  If not, change it to

1 and click the “OK” button.
Windows 2000
1. From “Start” choose “Settings”, then “Printers”.
2. Select the printer you are using.
3. Under “File” menu, choose “Printing Preferences”
4. Click on “Advanced”, “Copy Count” should say “1 copy”.  If it does not, change it then click

“OK”.
Windows XP
1. From “Start” choose “Control Panel”,
2. Then “Printers and other Hardware”,
3. Under “Pick a control Panel Icon” choose “Printers and Faxes”,
4. Click once on the printer you are using and in the “Printer Tasks” box on the right side of the

screen, choose “Set Printer Properties”.  Under the “Advanced” file tab, choose “Printer
Defaults”.

5. Check under print job to be sure the copy number is set to 1.  If not, change it to 1 and click
on the “OK” button.  Then click on the “OK” button again.

Will Not Print – Wrong Paper Size Indicated
Problem: Printer indicates that it needs legal sized paper and will not print.
Cause: Computer settings may be set to wrong sized paper.
Solution: Check the printer setting by using the appropriate method for your operating

system.
Windows 3.1 or Windows 3.11
1. From “Program Manager” open “Main”.
2. Then “Control Panels”.
3. Then “Printers”.
4. Then “Setup”.  This window will show paper size and should be set to Letter 8 1/2” X 11”

and the “Orientation” should be set to Portrait.  If not, change it and click the “OK” button.
Windows 95, 98, NT or ME
Method A
1. From “Start” go up to “Settings”.
2. Then “Printers”.
3. Then click on the Printer Icon.
4. Then select the Printer you want to use.
5. In the pull down menu select “Properties”.
6. Then “Paper”.  This window will show paper size and should be set to Letter 8 1/2” X 11”

and the “Orientation” should be set to Portrait.  If not, change it and click the “OK” button.
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If you cannot get into Properties as described above, try Method B
1. From “Start” go up to “Settings”.
2. Then “Control Panel”.
3. Then “Printers”.
4. Click once to highlight the Printer Icon.
5. Then go up to the “File” menu, pull down the menu and select “Properties”.
6. Then “Paper”.  This window will show paper size and should be set to Letter 8 1/2” X 11”

and the “Orientation” should be set to Portrait.  If not, change it and click the “OK” button.
Windows 2000
1. From “Start” choose “Settings”, then “Printers”.
2. Select the printer you are using.
3. Under “File” menu, choose “Printing Preferences”
4. Click on “Advanced”, “Paper Size” should say “Letter””.  If it does not, change it then click

“OK”.
Windows XP
5. From “Start” choose “Control Panel”
6. Then “Printers and other Hardware”,
7. Under “Pick a control Panel Icon” choose “Printers and Faxes”,
8. Click once on the printer you are using and in the “Printer Tasks” box on the right side of the

screen, choose “Set Printer Properties”.  Under the “Advanced” file tab, choose “Printer
Defaults”.

9. Check under size choose paper size “Letter (8 1/2 x 11 in)” by clicking on the correct icon.
Make sure the page orientation is set to “Portrait”.  Click on the “OK” button.  Then click on
the “OK” button again.

Screen Display
Improper Screen Display
Problem: Form appears in an incomplete form.  For example, words or lines or parts of

them are missing.
Cause: Insufficient memory for screen display in the number of colors and resolution

specified in your Windows program.
Solution:  Try changing colors and resolution settings from 800 x 600 to 640 x 480, by

using one of the following methods.  This may also resolve an associated printing
problem.

Windows 3.1 or Windows 3.11
7. From “Program Manager” open “Main”.
8. Then “Windows setup”.
9. Choose “Options”.  Click on “Display” by using the down arrow, choose 640 x 480 and try.
10. Click “OK”.
Windows 95, 98, NT, 2000 or ME
1. From “Start” go up to “Settings”.
2. Then “Control Panel”.
3. Double click on “Display”.  Choose the “Settings” file tab.  Adjust color and screen area

(Pixels) to less.
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4. Click on “OK”.
Windows XP
1. From “Start” choose “Control Panel”.
2. Then choose “Appearance and Themes”.
3. Under “pick a task” choose “Change the screen resolution”.
4. Under the Settings” file tab, adjust the “Screen resolution” box to fewer pixels.  Click “OK”.

Improper Screen Display (additional possible solution for Windows 98, 2000, ME, NT or XP)

Problem: Windows appears in an incomplete format.
Cause: Screen oddities can be cause by problems with video optimization.
Solution:  Reduce hardware acceleration.
Windows 98, ME, 2000 or NT
1. From “Start” go up to “Settings”, choose “Control Panel”.
2. Double click on “Display”. Choose the “Settings” file tab.  If you have an “Advanced” button,

click on it.
3. Then if you have a “Performance” tab (Windows 2000 choose “Troubleshooting”), click on it

and reduce the “Hardware Acceleration”.
4. Click on “OK”
5. Then click on “OK” again.
Windows XP
1. From “Start”, choose “Control Panel”.
2. Then choose “Appearance and Themes”,
3. Under “Pick a task”, choose “Change the screen resolution”.
4. Choose the “Advanced” button under the “Troubleshooting” file tab.  Reduce the “Hardware

Acceleration”.
5. Click on “OK”,
6. Then click on “OK” again.

Improper Screen Display
Problem: You have problems with improper screen display.
Cause: Your hard drive may need to be checked for problems with the drive or you may

need to defragment your hard drive.
Solution: Run the scan disk program to see if there are any errors and then run the disk

defragmenter program to reorganize the hard drive so that all of each program
will be in the same place on the hard drive.  If you have more than one hard
drive, you should perform scan disk and disk defragmentation on each drive.
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Windows 3.1 or 3.11

Scan Disk
1. Exit “Windows” by choosing “File” and “Exit Windows” from the “Program Manager” window.
2. When the DOS prompt comes up (C:\>) enter “scandisk” and push “Enter”.
3. Follow the instructions of the scan disk program.  It will tell you if there are errors and if it can fix

them.  You may be given the opportunity to create an “Undo Disk”, it is always wise to create an
undo disk.  If your computer works fine and you are not missing any files you can always reformat
the floppy disk.

4. Get back to Windows by entering “win” and pushing “Enter” at the DOS prompt (C:\>).

Disk Defragment
1. Exit “Windows” by choosing “File” and “Exit Windows” from the “Program Manager” window.
2. When the DOS prompt comes up (C:\>) enter “defrag” and push “Enter”.
3. Follow the instructions of the disk defragmentation program.
4. Get back to Windows by entering “win” and pushing “Enter” at the DOS prompt (C:\>).
Windows 95, 98, NT or ME

Scan Disk
1. From “Start” go up to “Accessories”.
2. Choose “System Tools”.
3. Then choose “Scan Disk”.
4. Then highlight the hard drive you need to scan and click on the “Start” button.
5. Follow the instructions of the Scan Disk program.  It will tell you if there are errors and if it can fix

them.  You may be given the opportunity to create an “Undo Disk”, it is always wise to create an
undo disk. If your computer works fine and you are not missing any files, you can always reformat
the floppy disk.

Disk Defragment
1. From “Start” go up to “Accessories”.
2. Choose “System Tools”.
3. Then choose “Disk Defragmenter”.
4. Follow the instructions of the Defragmentation program.
Windows 2000 or XP

Scan Disk
1. Double click on the “My Computer” icon on your desktop (Windows XP, from “Start” choose “My

Computer”).
2. Then select the hard drive you need to scan.
3. From the “File” menu on the tool bar, choose “Properties”.
4. On the “Tools” tab, under “Error Checking”, click “Check Now”.
5. Under “Check Disk Options”, select the “Scan for and attempt recovery of bad sectors” check box.

Disk Defragment
1. From “Start” choose “Programs” ( “All Programs” in Windows XP).
2. Choose “Accessories”.
3. Choose “System Tools”.
4. Then choose “Disk Defragmenter”.
5. Click on the “Defragment” button.
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 Small Screen
Problem: Screen display appears in reduced screen size and windows appear in an

incomplete manner.
Cause: This program is designed to function on a maximized screen display, you may

have inadvertently reduced the screen display and exited.
Solution:  Restore the screen size to normal or maximized.
1. Click on the maximize button in the extreme upper right hand corner of the screen
2. Then exit NDF Withholding and reopen.  The program will open showing your screen

maximized.

Small Screen (additional possible solutions for Windows 98, ME, 2000 or XP)

Problem: Screen display appears in reduced screen size and windows appear in an
incomplete manner.

Cause: This program is designed to function on a maximized screen display, you may
have inadvertently reduced the screen display and exited.

Solution:  Restore the screen size to normal or maximized.
From a Shortcut Icon
1. Right mouse click on the “NDF – Withholding” icon and choose “Properties”.
2. Under the “Shortcut” file tab, the “Run” line should be set to “Normal Window” or Maximize”,

not “Minimize”.
3. Click on the “Apply” button and choose “Close”.
From Start
1. From “Start”, choose “Programs” (Windows XP choose “All Programs”), then NDF-

Withholding, then right mouse click on the “NDF – Withholding” and choose “Properties”.
2. Under the “Shortcut” file tab, the “Run” line should be set to “Normal Window” or Maximize”,

not “Minimize”.
3. Click on the “Apply” button and choose “Close”.


